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Introduction

This is an introductory level, instructor-led workshop. This hands-on session will show you some
good sites for freely available spatial data, tips on digging for data, and how to download and
convert various file types. The Web is a treasure trove of freely available data. ALL you have to
do is find it, download (or access) it, and get it into a usable format. This workshop will be
helpful for anyone using GIS data or beginning a GIS project,and especially for those using data
from different sources.

Prerequisites

GIS I: ArcMap Introduction or equivalent experience

Objectives

* Identify key factors in looking for and
getting data, such as scale, scope of
project, quality of data, etc.

* Become familiar with strategies for
finding data and a few good download
sites

* Become familiar with file formats
frequently encountered when
downloading data

e Use and download data from an online
interactive map and ftp site

Learn about common compression
formats and conversion methods for
spatial data

Learn how to find and read metadata

Use ArcCatalog to access metadata and
preview data

Connect to data via the Web in ArcMap,
using an internet mapping service

Define the geographic projection for a
dataset



e Learn about the structure of common * Become familiar with land cover and
vector and raster formats, such as land use data
TIFFs, shapefiles, and coverages

Definitions

Term

Definition

arc interchange file

file with .e00 extension often used to compress Arclnfo coverages for
transfer via the web or other means; ArcGIS converts .e00 files (fixed-
length ASCII format) to coverages.

coverage

vector data format that is native to Arcinfo; a coverage stores
geographic features as primary features (arcs, nodes, polygons, etc.)
and secondary features (tics, map extent, etc.) (www.esri.com).

grid

raster data format in which features are represented by cells (or
pixels) with same value and cells are organized in a grid of rows and
columns; raster format is appropriate for data that vary continuously
over space such as elevation; images and grids are types of raster
data.

metadata

information describing data such as date created, projection, scale,
etc.; often formatted according to standards such as FGDC; available
in various formats such as web pages, text files, embedded in data
file, etc.

projection

map projections describe ways to represent areas on the Earth’s
surface (three-dimensional) on a flat surface such as a map; imagine
trying to wrap a piece of paper around a globe; all projections distort
shape, area, distance or direction to some extent.

raster

type of spatial data in which features are represented by cells (or
pixels) with same value and cells are organized in a grid of rows and
columns; raster format is appropriate for data that vary continuously
over space such as elevation; images and grids are types of raster
data.

shapefile

vector data format that stores geographic features and their attributes;
geographic features can be represented by points, lines, or polygons
(areas) (www.esri.com).

vector

type of spatial data in which features are represented by points, lines
or polygons; coordinate-based structure (XY or latitude-longitude)
commonly used to represent linear features; coverages and shapefiles
are types of vector data.

Acronyms

DEM- Digital Elevation Model, or elevation data, or elevation grid

DOQQ- Digital Orthophoto Quarter Quadrangles, or orthophotos, orthos or air photos
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DRG- Digital Raster Graphics, or topographic map, or topos

IMS- Internet Mapping Service

UTM- Universal Transverse Mercator

Strategies for finding spatial data

First check with logical data sources (original or official providers), i.e. for census data go to the

Census Bureau, for local data such as air photos and parcels, go to city or county government.

In addition, try searching down this list:

(0]

Campus/ Library sites
o ADRSA data links: www2.ku.edu/~adrsa/data.shtml

o Library holdings data: www2.ku.edu/~adrsa/data.shtml#library
o0 ESRI Data and Maps (hundreds of data layers that accompany ArcGIS):
http://qis.lib.ku.edu/esri_data _maps.shtml

Local or state government sites, i.e. KS Data Access and Support Center (state GIS

clearinghouse): http://maps.kansasqgis.org/kgcc/catalog/catalog.cfm

Federal government sites, i.e. US Geological Survey land cover data links:

http://landcover.usgs.gov/landcoverdata.php#na

Non-profit sites, i.e. MapDex (database of more than 35,000 internet map services

containing over 600,000 GIS layers): www.mapdex.org/search/

Commercial sites, i.e Geography Network (numerous datasets available through internet

mapping services): www.geographynetwork.com

HANDS-ON EXERCISE: LAND COVER MAPPING

Pick Your County

0
0

Pick a county in Kansas; you will find and work with data for this county (see map pg. 5).
We will look at how land is used and classified in Kansas, by working with land use and land
cover data. These datasets typically include vegetation types, developed vs. undeveloped
areas, forested vs. non-forested areas, etc.

We will also find some basemap data, such as orthophotos and locations of cities.
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Find data for locations of cities
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Find land use/ cover data (KARS)
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Go to the ESRI Data and Maps download page: http://gis.lib.ku.edu/esri_data maps.shtml
Click on the ‘Download Data for...United States’ link (notice the links for metadata)

Scroll to ‘U.S. Populated Places (Points)’

Click on this link to open the zipped file

Save (extract) the resulting files to c:\wutemp

Click on Start Menu - Programs - ArcGIS - ArcCatalog

In ArcCatalog, navigate to layer so it shows on left side

Click ‘Preview’ tab on the right to ensure download worked

0 Go to the DASC site: http://www.kansasgis.org/catalog/catalog.cfm

Choose the ‘Land Surface Geology Soils’ category

o

o0 Choose ‘Land Cover’

0 Read over the metadata:

0 What is the format?

o0 How are the data
organized (tiled)?

0 What is the projection?

o Click on ‘Arcinfo
Interchange,Shapefile’ to start
download

o Click on your county to open the
zipped file

0 Save (extract) the resulting files to
c:\wutemp

Convert EOOQ file to coverage

I

menu)

o
DQa Preview:
TR v

L

Land Cover identified by 10 cover types. Pu

0 Download Files:

» Download File: ArcInfo
Interchange,Shapefile
» Projection/Datum: Geographic/NADS3
» Tiling Scheme: State,County
[View Tile Reference]

General Information:

» Data Creator: Kansas Applied Remote
Sensing Program (KARS)

o Click on the red toolbox to open ArcToolbox (or select under the Window
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o Click on Coverage Tools = Conversion - To Coverage-> Import from Interchange
File

Note, in standalone versions of ArcGIS, you can access this tool from ArcCatalog by right-
clicking in the gray area of the menu and choose ‘ArcView 8.x Tools’

o For the input file: navigate to c:\ wutemp\ and choose the .e00 file (compressed Arcinfo
coverage for county land cover)

0 Save the output file in c:\wutemp as landcov10
o Click OK — .
util. 200 ‘ |Iﬁf0
EOD File II
il
o In

ArcCatalog, navigate to layer so it shows on left side
o Click ‘Preview’ tab on the right to ensure download worked

Find more land use/ cover data (USGS)

The U.S. Geological Survey provides the National Land Cover Dataset (NLCD). Download
NLCD data for your county, via an interactive map using the instructions below. Note, you can
find the NLCD for the entire state, as one large TIFF via FTP download:
http://edcftp.cr.usgs.gov/pub/data/landcover/states/.

0 Go to the USGS interactive mapper site: http://gisdata.usgs.net/website/MRLC/viewer.php

0 Click the ‘Zoom to Region or Area’ tool I§ under Zoom, and select
Kansas at bottom

o0 Onthe ‘Display’ tab at right, click on ‘Boundaries’ and turn on the
counties layer, to find your county

o Click on the ‘Download’ tab

o Click on ‘Land Cover’ and make sure NLCD 1992 Land Cover is
checked

0 Under ‘Downloads’ at left, click on the ‘Define Download Area’ tool "k;.

o Click and drag a box around your county; if needed, use the county
map at the beginning of this handout to find your county

o Click on the ‘Download’ button

0 Open the zipped file

0 Save (extract) the resulting files to c:\wutemp (note the file names and
that there IS a metadata file)

o Navigate to layer in ArcCatalog (list on the left) and click ‘Preview’ tab on the right to ensure

download worked

Click on Start Menu - Programs > ArcGIS - ArcMap

o Drag layer into ArcMap

o

Bring in data

. + . .
* Click on the ‘Add Data’ button | ™ to bring data layers into ArcMap

* Navigate to: c:\ wutemp



ADRSA/Libraries GIS Training

Hold down the Control (Ctrl) key and click on the places.sdc and landcov10 layers
(highlight) to add all at once

Change how places/ cities display

Turn on only this layer

Right-click on this layer title in table of contents, and choose ‘Zoom to Layer’ (note the area
covered by data)

Right-click on layer title and choose ‘Open Attribute Table’
Examine table to ascertain what field we can use to display only cities in KS
Close the table

Set display properties so only cities in KS show (hide all other cities in U.S.): Right-click on
layer title and choose ‘Layer Properties’

Click on the ‘Definition Query’ tab and then on the ‘Query Builder’ button to build an
equation that displays only cities in KS (in both view and table)

o Double-click on field name (ST) and Single-click on operator (=)

o0 Click ‘Get Unique Values’ button to display all possible field values (state
abbreviations)

o Double-click on field value (KS) or type in ‘KS’ to complete the equation: "ST" =

IKSI
o Click OK
LR
On the ‘Symbology’ tab, click on the point and change symbol color, size, etc.
Click OK

Click on the ‘Zoom In’ tool @ then click and drag a box around the cluster of points
representing cities in KS

. |
Use the ‘Previous Extent’ button ‘ to return to the last zoom

Click on Identify tool F6 , then on a city to get tabular information such as city name

Add base map (orthophotos) using IMS

0
0

(0]

Go to the KS GIS clearinghouse (DASC): http://www.kansasgis.org/catalog/catalog.cfm
Choose the ‘Imagery and Raster’ category, and notice the numerous types of raster data
available, including DRGs, DOQQs and satellite imagery
Choose the ‘MrSID Compressed Digital Orthophoto Counties 2002’ and look over the
information (metadata) provided:

o0 What year was the imagery collected?

0 What format is it in?
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0 What is the projection?

Notice you can ‘Connect to a Web Service,’ or internet mapping service (IMS). An IMS allows
you to use data via the web, instead of downloading and using from your computer. An IMS is
suitable if you mainly need to display data, and not process or manipulate it. Depending on
numerous factors, including website architecture, your system and software setup, size of
dataset, etc., an IMS may perform too slow to be useful.

(0]

Click ‘arcims image service’ and follow the directions to ‘add the service’ or connect to the
data in ArcCatalog so you can use the data in ArcMap

In ArcCatalog;s left-hand listing of drives/folders, click on the plus sign to select GIS
Servers, then select Add ArcIMS Server

Copy the data server URL (maps.kansasgis.org) into the box provided

: i S g Open ArcMap: Click on Start Menu - Programs - ArcGIS
- ArcMap

Expand maps.kansasgis.org and scroll down to the
kgcc_Imagery map service

Drag it into ArcMap

In ArcMap, expand this layer and check the boxes next to
‘kgcec_Imagery’ and ‘View Aerials 2002’

@ O | @|Refresh View Hit the Refresh button at bottom (chasing arrows) if

imagery does not draw or only partially displays.

Change how orthophotos display

O O0OO0OO0OO0OO0OOo

o

Turn all layers on to make sure you can see them at once

Turn on only imagery layer (kgcc_Imagery)

Zoom out so you can see the entire state aerial layer

With the view unprojected, we can see all layers but the shape of Kansas appears distorted
Setting a view projection will display the data more accurately, closer to the real shape
Choose View = Data Frame Properties

On the Coordinate System tab, click Predefined - Projected Coordinate Systems - UTM
-> NAD1983 - NAD1983 UTM Zone 14N

Click OK and notice how the shape of Kansas changes

Now turn layers on to see if they all draw (KARS cover does not draw because the file
contains no projection information)

Notice that all layers draw except for landcov10 because this file contains no projection
information.

o

Remove this layer

Define projection for KARS land cover data

Metadata on the DASC site tells us this dataset is in the Geographic/NAD83 projection, the
same as the cities data. However, this projection information was not encoded into the data file
itself, so ArcMap does not know the projection in which to draw the data (no geographic ‘frame
of reference’). For ArcMap to recognize the projection, we must define it using ArcToolbox.

(0]

o Click on Data Management Tools = Projections and Transformations = Define
Projection
Click on the dropdown arrow under ‘Input Dataset...” and choose landcov10

Z o Click on the red toolbox to open ArcToolbox (or select under the Window menu)
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o Click on the Coordinate System icon L
Click ‘Import’ and navigate to the location of the cities/places layer (c:\wutemp), to define the
projection using that of the cities layer, as they are the same

Click OK and OK again

Close the define projection window and ArcToolbox when/if it completes successfully
Add layer back in

Right-click on title to access layer properties, and click on the Source tab to see that
coordinate system information has now been added

o

O O O o

Save Settings and Data as One File

* Choose File > Save As and save map document in c:\wutemp

You can save existing data, settings, display schemes, etc. as ONE file. Map document files
end with .mxd and do not store actual data layers, but references to those layers and settings
for data and the data frame. Note that the population table we joined is not permanently
attached to the block table. Exporting the block layer as a new shapefile would secure the join,
but saving as an MXD will save it temporarily.

* As you work, choose File > Save to save changes

Change how KARS land cover data display
0 Right-click on this layer and choose ‘Zoom to Layer’
Right-click on layer to open attribute table
Find the a field (column) that might be useful to show land cover classes
Right-click on layer and open layer properties
On the Symbology tab, click on ‘Categories’ and select ‘Unique Values’
* Change the ‘Value Field’' to ‘COV_CLASS’ (land cover class)
: : : : : : * Click on the ‘Add All Values’ button

e O OO

’Dlaw categories using unique values of one field. Import... I . Click on the DiSpl ay tab and set the
= L FHE transparency level at 40 to 60% so
CEERE [ ﬂ_:_ﬂ the air photos underneath can be
Symbol | Value | Label | Count | 4] . Se.en

<Heading> COV_CLASS Click OK

I Commercial/industrial Commercial/Industrial ?

I Cropland Cropland ?

B Girassland Grassland ?

I Other Other ? ﬂ
I Residential Residential ? ﬂ
I Urban-Grassland Urban-Grassland ?

[ Urbanwater Urban-w ater ?

I Urbanwoodland Urban‘woodland ?

B v ater Water ? ]
I -/ oodland Woodland ? R

Change how NLCD land cover data display
0 Right-click on layer and open layer properties
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0 Onthe General tab, type a more descriptive
name for the layer, such as nlcd land cov

* Onthe Symbology tab, click on ‘Unique Values

* Type in overall class names in the Label column
using the metadata below, i.e. for 10s type
‘Water,’ for 20s type ‘Developed,’ for 30s type
‘Barren,’ etc.

Class number corresponds to the value column in
the attribute table. All classes may not be
represented in a specific state data set.

Water
11 Open Water
12 Perennial Ice/Snow

Developed

21 Low Intensity Residential

22 High Intensity Residential

23 Commercial/lIndustrial/Transportation

Barren

31 Bare Rock/Sand/Clay

32 Quarries/Strip Mines/Gravel Pits
33 Transitional

Vegetated; Natural Forested Upland
41 Deciduous Forest

42 Evergreen Forest

43 Mixed Forest

Symbol | <VALUE> | Label

i 2 11 Water
, 21 Developed
22 Developed
| 23 Developed

Barren

Barren

Barren
Yegetated

42

Shrubland
51 Shrubland

Non-natural Woody
61 Orchards/Vineyards/Other

Herbaceous Upland
71 Grasslands/Herbaceous

Herbaceous Planted/Cultivated
81 Pasture/Hay

82 Row Crops

83 Small Grains

84 Fallow

85 Urban/Recreational Grasses

Wetlands
91 Woody Wetlands
92 Emergent Herbaceous Wetlands

* Click on the Display tab and set the transparency level at 40 to 60% so the air photos

underneath can be seen
e Click OK

Compare land cover datasets

No. of Date | Compressed | Uncompressed Projection Resolution
classes Format Format

KARS 10 1993 | .e00 (Arcinfo Coverage Geographic 30m?~?

Land Interchange) NADS83

Cover

USGS 21 1992 | .zip TIFF Geographic 30m

Land NAD83

Cover

(NLCD)

* Choose an area in your county and turn land cover layers off and on to explore how these

layers and the orthophotos match (or don’t matc

h) up

What are some of the major differences between these 2 land cover datasets?

10
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Do they both classify all water bodies on the orthos, as water?

Note: Please complete a workshop evaluation. An online
evaluation is linked from the internet browser ‘Favorites’
menu.

11
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More Information

KU GIS Day is November 15. Get details on the student competition, find a schedule and
register at: http://www.lib.ku.edu/qis/.

ArcGIS software manuals, or ‘ESRI Digital Books’ are now available via the Library Web:
http://qis.lib.ku.edu/esri_dig_books.shtml.

All workshops offered through Information Services are free to KU students, staff, faculty, and
approved affiliates. To learn more about or register for workshops, receive announcements of
upcoming workshops, and track workshops you attend, visit the KU Libraries Instruction Web
site at www.lib.ku.edu/instruction. You can also check our online schedule at
www.ku.edu/acs/schedule for a list of class offerings and availability.

Upcoming GIS Workshops (http://www2.ku.edu/~workshops)
o GIS II: Mapping Your Data, Oct. 31

Getting Additional Help

Be part of the KU GIS user community by joining kugis-I

0 To subscribe to listserv, send email to: listproc@ku.edu

o Inthe first line of the body of the message enter: subscribe kugis-l yourfirstname
yourlastname

Online Tutorials- Learn GIS at your own pace through virtual tutorials. ESRI online tutorials are
available free to KU-affiliates and can be used by individuals or classes. See a list of courses at:
www.kars.ku.edu/user/vc_courses.shtml and email or call (data@ku.edu, mickey@ku.edu or
864-1238, 864-0454) to register for one or more.

GIS and Data Lab, 105 Anschutz Library
Hours (during classes): Mon-Thurs 9AM-8PM, Fri 9AM-5PM, Sat/Sun 1PM-5PM
Contact: data@ku.edu or 864-1238 (Rhonda Houser), 864-7777 (Mickey Waxman)

More information: www.lib.ku.edu/qgis

Last Update: 10/25/2006
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